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Summary of Revisions from Version 1 
 

Section Page Revision 
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Appendix – Troubleshooting 15 Added new Troubleshooting section 

 
 
Summary of Revisions August 2016 
 

Section Page Revision 

Computer Specification 5 
Minor revisions to Computer 
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Appendix – Troubleshooting 15 Added new User validation failed issue 

 
 
Summary of Revisions July 2017 
 

Section Page Revision 

Amending the Assessment 11 
Addition to instructions on adding 
comments 

Amending the Assessment 11 
Revision to state that content can be 
amended 

 
Summary of Revisions January 2021 
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Viewing the Assessment 9 
Revised instructions for viewing a 
question paper and marking instruction 

 
Summary of Revisions March 2021 
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Viewing the Assessment 9 
Revised instructions for viewing a 
question paper and marking instruction 
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1. Assessment Creation Overview 
 

ItemBank is designed for use in both paper-based and onscreen assessments; however, this guide 
is intended for use with paper-based assessments only. An assessment is a question paper and its 
associated marking instructions. 
 

Principal Assessors will use ItemBank to: 

• preview the complete question paper and marking instructions in advance of the Assessment 
Review Meeting. 

 

An overview of the Assessment Creation process is detailed below: 
 

Step 1: Log in to ContentProducer and select items for the Assessment 

 

Step 2: E-mail SQA’s NQ Assessment team with details of the items selected 

 

Step 3: SQA’s NQ Assessment team will create the Assessment in ItemBank and e-mail you when 
the Assessment is ready for viewing. 

 

Step 4: Log In to ItemBank 

 

Step 5: ‘Check Out’ the Assessment Version 

 

Step 6: View the ‘Printed Assessment’ (ie the complete question paper and marking instructions) 

 

Step 7: If necessary, mark up any minor amendments required to the question paper and 
marking instructions & upload to ItemBank 

 

Step 8: E-mail SQA’s NQ Assessment team to advise that the question paper and marking 
instructions are now ready.  

 

Step 9: SQA’s NQ Assessment team will issue paper copies of the question paper and marking 
instructions to the Question Paper Reviewers, the Principal Assessor and the Qualifications 

Manager/Officer. 

 

Step 10: Assessment Review Meeting held and any changes are made to the question paper and 
marking instructions. 

 

Step 11: Reviewed Assessment approved. 
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2. Getting Started 
 
(a) Computer Specification 
 
Your computer must meet the following minimum specifications to run ItemBank. 
 

Processor 2.33GHz Single core CPU 
Or 
1.2GHz Dual core CPU 
 

Memory 1GB 
 

Display Screen resolution of 1024 x 768 
Graphics card with at least 64MB of memory 
 

Internet Browser 
 

Surpass Viewer* 

Microsoft Word 2007 or above 
 

 
*See Surpass Viewer installation guide for ItemBank. 
 
(b) Key Contacts 
 

Activity Contact Telephone/e-mail 

Using ItemBank 
Username/password 
queries 
 

ADD – NQ Assessment 
 

question.papers@sqa.org.uk 
0345 213 6807 
 

Subject support & advice Qualifications Manager 
Qualifications Officer 

 

 
(c) Security 
 
Please refer to Section 2 - Security of confidential materials in the Guidance for Producing and 
Quality Assuring Items, Question Papers and Marking Instructions for a note of security procedures 
which must be followed when using ItemBank. You can access this guidance via the Appointee 
Portal. 
 
  

https://www.sqa.org.uk/sqa/files_ccc/sqa-surpass-viewer-installation-guide-itembank.pdf
mailto:question.papers@sqa.org.uk
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3. Logging In and Homepage 
 
(a) Logging In 
 
You will be sent an e-mail from question.papers@sqa.org.uk detailing the address for logging in to 
ItemBank and your username. You will be sent an auto-generated e-mail from ItemBank containing 
your password. 
 

• Follow the link in the e-mail. 

• Enter your username and password. Please note the password is case sensitive. 
 

 
 

• Click ‘Log In’. 
 
(b) System Lock 
 
After a period of inactivity, ItemBank will lock you out and you will have to re-enter your password. 
 

 
 

• Enter your password and click ‘Log In’ to continue working in ItemBank. 
  

mailto:question.papers@sqa.org.uk
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(c) Homepage 
 
This is the ItemBank homepage. 
 

Home   Assessment Version Management  Log Out 

 

 
 

 Change My Details Change My Password 

 

• Clicking on any of the tabs along the top of the page will take you to the relevant screen -
‘Home’ or ‘Assessment Version Management’. 

• To log out of ItemBank use the ‘Log Out’ button at the top of the screen. 

• To change any of your details (name or e-mail address) use the ‘Change My Details’ button at 
the bottom of the screen. 

• To change your password use the ‘Change My Password’ button at the bottom of the screen. 
When you first log in to ItemBank you should change your password. 
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4. ‘Check Out’ the Assessment Version 
 

• Click on ‘Assessment Version Management’ to access the Assessment Version Management tab. 
 

 
 

 
An ‘Assessment Version’ refers to a question paper for a specific year. 
Within this tab you should see a list of any question papers for which you are responsible. Please 
get in touch with NQ Assessment if you do not see your question papers. 
The Assessment Version Name column will indicate the year of the question paper. 
 

• If necessary, the Assessment Version Name column can be expanded by clicking and dragging 
the column edge. 

 

  Assessment Version Name 

 

  
 
 

  Check-Out 

 

• Select the Assessment Version from the list (it will then be highlighted in blue). 

• Click ‘Check-Out’. 
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5. Viewing the Assessment 
 

• Click on the ‘Printed Assessment’ button in the Assessment Version Management tab. 
 

 

 
 

 Printed Assessment 

 

• Click on the question paper that you are currently working on in the Printed Assessments box. 
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• To view the question paper click ‘Download’ in the Assessment Paper section. 
 

  
 

 Download 

 

• To view the marking instructions click ‘Download’ in the MarkScheme section. 
 

 

 
 

 Download 

 

• The file will now download. 

• Close the blank browser tab that has appeared. 

• An icon will appear in the Surpass Viewer window to indicate when the file has downloaded. 
 

 
 

• Click the arrow icon to open the file, a compressed (zipped) folder. 

• Within this folder you will see the Microsoft Word document. The file title will be the name of 
the question paper or marking instruction followed by Exam Paper or Mark Scheme and then 
the version number, eg, 2012 Fashion and Textile Technology Int 2_Exam Paper_1.docx 

• You can then open this file in Word and view the question paper/marking instruction. 

• Close Word and return to the Printed Assessment screen in ItemBank. 
 
Note: Files are automatically downloaded to C:\Users\USERNAME\Downloads where USERNAME is 
your computer username. You must delete the question paper and marking instruction from this 
folder once you have finished. 
 

• Once you have viewed the question paper and marking instructions proceed to the Amending 
the Assessment section on page 11 if you require any amendments.  
 

• If no amendments are required proceed to the Completing the Assessment section on page 13. 
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6. Amending the Assessment 
 
Once you have viewed the complete assessment, you may notice that minor amendments to the 
content or layout are required.  Instructions for viewing the assessment can be found in the 
Viewing the Assessment section (page 9). 
 
Minor amendments can be made as required. Alternatively, comments can be added to indicate 
where amends are required.  The NQ Assessment team will use these comments to make the 
required amends. 
 

 
 

 New Comment Highlighted Text 

 

• To mark up minor amendments on the question paper or marking instructions, highlight the 
text you wish to change, or position the cursor where you need the layout changed and select 
‘New Comment’ from the ‘Review’ menu. 

• Enter the amendment or instruction in the comment box. 
 

• Select ‘Save As’ from the ‘File’ menu and save the amended question paper or marking 
instructions to your computer. Remember the filename and the folder where you have saved 
the question paper or marking instruction to. 

• Close Word and return to the Printed Assessment screen in ItemBank. 
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 Upload 

 

• Click ‘Upload’ in either the Exam Paper or Mark Scheme section. 
 

  
 

 OK Browse 

 

• Click ‘Browse’ and navigate to where you saved the question paper or marking instructions on 
your computer. 

• Insert a comment in the Comments text box (eg Version 2) and click ‘OK’. A comment is 
mandatory – it cannot be left blank, otherwise you cannot click ‘OK’. (Please do not use the & 
symbol in the comment box as this causes an error to occur.) 

 
Note: Following this, you must delete the question paper and marking instructions from your own 
computer.  
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7. Completing the Assessment 
 

• Click ‘Close’ to close the Printed Assessments screen and return to the Assessment Version 
Management tab. 

 

  
 

 Close 
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 Check-In 

 

• Select the assessment version from the list (it will then be highlighted in blue) then click 
‘Check-In’. 

• Notify the NQ Assessment team (question.papers@sqa.org.uk) that you have checked-in the 
assessment ready for the Assessment Review meeting. 

 
Note: NQ Assessment staff will carry out any marked up changes before the question paper and 
marking instructions are printed and distributed in advance of the Assessment Review meeting. 
  

mailto:question.papers@sqa.org.uk
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8. Appendix – Troubleshooting 
 
Issue 

• You haven’t received your password to access ItemBank. 
 
Resolution 

• Check the junk or spam filter in your e-mail. As an auto-generated e-mail your e-mail provider 
may incorrectly identify it as a spam e-mail. 

 
 
Issue 

• Some elements of ItemBank appear to be cut off the screen or buttons appear to be 
inaccessible. 

 
Resolution 

• Check that your screen resolution is set to the minimum recommended in the computer 
specification (1024 x 768). 

• Before logging in to ItemBank, set your Internet browser to full screen, commonly accessed by 
pressing F11 on your keyboard. (Once you have finished using ItemBank press F11 again to exit 
full screen mode.) 

 
 
Issue 

• Cannot find the amended question paper or marking instructions which you have saved. 
 
Resolution 

• Check the recent files list in Microsoft Word, commonly accessed via the File menu or Office 
menu depending on what version of Microsoft Word you are using. 

• Search for the file on your computer. The filename will be in the format: 
Year Subject Level_Exam Paper/Mark Scheme_Version Number.docx 
eg 2014 Classical Greek National 5_Exam Paper_1.docx 

 
 
Issue 

• When entering the username and password you are getting a “User validation failed” 
message 

 
Resolution 

• Check that you have entered your username and password correctly. The password is case 
sensitive so check you haven’t got Caps Lock switched on. 

• Check that you have entered the correct web address for ItemBank. The web address should 
contain the word itembank and the login screen should show ItemBank as in the following 
screenshot: 
 

 


